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Name _____________________
Class ______________
Date _________


Activity GS21: Conservation of Energy – PE to KE
(Motion Sensor)

Concept
DataStudio
ScienceWorkshop (Mac)
ScienceWorkshop (Win)

Energy
GS21 Conserve Energy.DS
G21 Conserve Energy
G21_ENER.SWS

Equipment Needed
Qty
Equipment Needed
Qty

Motion Sensor (CI-6742)
1
Masses
~2 kg

Balance (SE-8723)
1
Meter stick
1

Base and Support Rod (ME-9355)
1
Ruler, metric (15 cm)
1

Block
1
1.2 m Track System (ME-9429A)
1

“C” clamp
1
Tape
1 roll

Dynamics Cart (inc. w/ Track)
1


What Do You Think?

[image: image1.wmf]How well is energy conserved when the elastic potential energy of a spring is transformed into kinetic energy of a moving cart?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

Potential energy is sometimes called stored energy. A compressed spring has stored potential energy called elastic potential energy. Kinetic energy is called the energy of motion. An object in motion has kinetic energy.

The amount of force that a spring can push with depends on how far it is compressed and how strong the spring is (called the spring constant). Likewise, the amount of elastic potential energy (stored energy) a spring has depends on how far it has been compressed and the spring constant. 
[image: image38..pict]

A spring that is compressed a distance x from its normal position has an amount of elastic potential energy given by:


 EMBED "Equation" \* mergeformat  


where PEelastic stands for “elastic potential energy”, k is the spring constant and x is the distance that the spring is compressed.

The amount of kinetic energy that an object has depends on how much mass it has and how fast it is moving. The formula for kinetic energy is:


 EMBED "Equation" \* mergeformat  


where KE stands for “kinetic energy”, m is the mass of the object, and v is the speed of the object.

If energy is conserved, the elastic potential energy in the compressed spring will be completely transformed into kinetic energy when the spring pushes an object of mass m. 


SAFETY REMINDER
•
Do not let the cart hit the Motion Sensor.

•
Follow directions for using the equipment.
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For You To Do

In the Pre-Lab for this activity, measure the spring constant of the plunger spring in a dynamics cart. Put heavy masses on the end of the plunger to force the spring to compress. Measure the amount of distance that the spring compresses. Use DataStudio or ScienceWorkshop to make a Graph of force and position that will give you the value of the spring constant k. 

In the Procedure for this activity, use the Motion Sensor to measure the motion of a cart after it is pushed by the plunger spring as the spring de-compresses. Use DataStudio or ScienceWorkshop to record the motion and display the initial velocity and maximum kinetic energy of the cart. 

Use your data to compare the measured kinetic energy to the calculated elastic potential energy.

Pre-Lab

Equipment Setup and Data Recording

The dynamics cart has a spring-loaded plunger that can be used to push the cart to get it moving. The plunger has three notches so the plunger spring can be compressed to three different distances.


[image: image3.wmf]

When the plunger spring is fully compressed, the end cap is even with the end of the cart. When it is not compressed at all, it goes out about 3 cm.

1.
Put the dynamics on end with the plunger at the top. Place the 15-cm metric ruler on the side of the cart and line up the 0 cm mark on the ruler with the end cap of the plunger. Tape the metric ruler to the side of the cart.


[image: image4.wmf]

2.
Carefully add masses on top of the plunger until the plunger spring is almost fully compressed. Add up the total mass that it took to compress the spring. Use the ruler to measure the position of the end cap. Record the total mass and the position in the Data Table. 

•
You may need to steady the dynamics cart and the pile of masses to keep them from leaning.
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[image: image11.wmf]3.
Remove approximately one-fourth of the mass you used in the previous step. Measure the new position of the end cap. Record the amount of mass and the position in the Data Table.

4.
Repeat the previous step. Remove another one-fourth of the original mass (so one-half the original mass remains). Measure the new position of the end cap. Record the amount of mass and the new position in the Data Table.

5.
Remove another one-fourth (so one-fourth remains). Measure the position. Record the amount of mass and the new position in the Data Table.

6.
Remove the final amount of mass. Remove the metric ruler from the cart.

7.
In the Data Table, convert the positions from centimeters to meters (divide by 100).

8.
Convert the mass from grams to kilograms (divide by 1000). Convert from mass to force by mutlitplying the mass in kilograms by 9.8 newtons per kilogram (the strength of gravity at Earth’s surface).

Pre-Lab: Data Table



Position (cm)
Position (m)
Mass (g)
Mass (kg)
Force (N)

All mass






3/4 mass






1/2 mass






1/4 mass






no mass
0
0
0
0
0

Pre-Lab: Analyze the Data

1.
Use DataStudio or ScienceWorkshop to create a graph of Force versus Position in order to determine the spring constant from your data.

In DataStudio, do the following:

•
Open the file titled ‘GS21 Conserve Energy.DS’

•
In the Table display, type in your recorded values for position in meters and force in newtons. (Use the <tab> or <return> key to move from one cell to the next.) After you are done, click the ‘Edit Data’ tool ([image: image6.png]


). ‘Data’ will appear in the Summary list.

•
Drag ‘Data’ to the Graph icon in the Display list. 

[image: image12.wmf][image: image13..pict][image: image14..pict][image: image15..pict]•
In the Graph display, select ‘Linear’ from the ‘Fit’ menu.

•
The value of the slope is the spring constant, k.

In ScienceWorkshop, do the following:

[image: image16..pict]•
Click the ‘Notes’ window button in the Experiment Setup window to open a blank Experiment Notes window. You can import data into ScienceWorkshop using the Experiment Notes window.

•
Type in your recorded values for position in meters and force in newtons. Use the following format:


first number <TAB> second number <RETURN>

•
In this case, the first number is the value of position and the second number is the value of force. (Note: The numbers in the example are “made up”. Your numbers will probably be different.)

•
Use the cursor to highlight your numbers in the Experiment Notes window, or click the ‘Edit’ menu and pick ‘Select All’.

•
Click the ‘Edit’ menu and select ‘Copy’. 

[image: image17..pict]•
Click the Experiment Setup window to make it active. Click the ‘Edit’ menu and select ‘Paste’. 

•
The ‘Enter Data Cache Information’ window will open. 

•
Type in ‘Spring Constant’ for the ‘Long Name’, ‘Spring’ for the ‘Short Name’, and ‘N’ for ‘Units’. Click ‘OK’ when you are done.

•
The ‘Short Name’ appears in the Data list in the Experiment Setup window.

•
Click the ‘Display’ menu and select ‘New Graph’. The Graph display will show your data, but you may need to rescale the Graph in order to see it. 

•
Click the ‘Statistics’ button to open the Statistics area on the right side of the Graph. Click the ‘Autoscale’ button to rescale the Graph to fit the data.

[image: image18..pict]•
Click the ‘Statistics Menu’ button ([image: image7.png]


). Select ‘Curve Fit, Linear Fit’ from the Statistics menu. The Statistics area will show the formula of a line, the constant a1, and the slope a2. The slope is the spring constant, k, of your plunger spring.

2.
Record the value of your spring constant, k, in the Lab Report section.

Procedure

Remember, use the Motion Sensor to measure the motion of a cart just after it is pushed by the plunger spring as the spring de-compresses. Use DataStudio or  ScienceWorkshop to record and display the motion and the kinetic energy of the cart. Compare the measured kinetic energy to the calculated elastic potential energy.

[image: image19..pict]PART I: Computer Setup
1.
Connect the Motion Sensor stereo phone plugs to Digital Channels 1 and 2 on the ScienceWorkshop interface. Put the yellow-banded phone plug into Digital Channel 1. Put the other phone plug into Digital Channel 2.

2. 
Open the document titled as shown:


DataStudio
ScienceWorkshop (Mac)
ScienceWorkshop (Win)

GS21 Conserve Energy.DS
G21 Conserve Energy
G21_ENER.SWS

•
Note: ‘GS21 Conserve Energy.DS’ may already be open because it was used during the Pre-Lab. 

•
The document opens with a Graph display. The DataStudio document also has a Table display and a Workbook display. Read the instructions in the Workbook display.

PART II: Sensor Calibration and Equipment Setup 

Sensor Calibration

•
You should calibrate the Motion Sensor so it can use an accurate measurement of the speed of sound in air. You will need a meter stick and a flat surface that can be used as a target to reflect the pulses from the Motion Sensor. 

1.
Place the track on a horizontal surface. Put the cart near the middle of the track and level the track by raising or lowering one end so the cart will not roll one way or the other. Remove the cart when the track is level.

[image: image20..pict]2
Put the Motion Sensor at one end of the track. Place a flat surface (such as a book) exactly one meter away from the Motion Sensor. Adjust the target so that it can reflect the pulses from the Motion Sensor.

3.
In the DataStudio Setup window, double-click the sensor’s icon. Result: The Sensor Properties window opens. 

[image: image21..pict]4.
Click the ‘Motion Sensor’ tab. Result: The calibration window opens and the sensor begins to click a few times per second.

[image: image22..pict]5.
In the ScienceWorkshop Experiment Setup window, double-click the Motion Sensor icon. Result: The Calibration window opens.

6.
Calibrate the software.

•
First, make sure that the sensor is one meter from the target. 

•
Second, click the ‘Calibrate’ button in the Motion Sensor window. Result: The software calculates the speed of sound based on the calibration distance (one meter) and the round trip time of the pulse and echo 

7.
Click ‘OK’ to return to the Experiment Setup window.

Equipment Setup

1.
Clamp a block onto the table next to the end stop at one end of the track.

•
The block will keep the track from sliding one way when the plunger spring pushes the cart the opposite direction.

2.
Put the Motion Sensor at the other of the track.

3.
Put a pencil mark on the edge of the track 15 cm in front of the Motion Sensor.

4.
Measure the mass of the cart. Record the mass m in the Lab Report. 

[image: image23..pict]5.
Measure the length of the plunger relative to the end cap of the dynamics cart. Record the plunger length x in the Lab Report. 

6.
Fully compress the plunger spring on the cart, and lock the spring in position by pulling the end of the plunger bar upward slightly so one of its notches will ‘catch’ on the metal rail inside the cart’s end cap. 

[image: image24..pict]7.
Put the cart on the track so the end of the plunger bar is against the end-stop.

PART III: Data Recording
1.
Start recording data. (Click ‘Start’ in DataStudio or click ‘REC’ in ScienceWorkshop.) 

2.
Use the end of a pencil or similar object to tap down on the plunger release pin. 

•
Avoid getting your hand in the way of the pulses from the Motion Sensor. 

•
The cart will be pushed away from the end-stop by the plunger spring.

3.
Stop recording data when the cart gets about 15 cm from the Motion Sensor. 

•
Catch the cart so it doesn’t run into the Motion Sensor.

•
Run #1 will appear in the Data list in the Experiment Setup window.

4.
Repeat the data recording process two more times.

Optional: Data Recording – Cart and Extra Mass

1.
Put a mass bar in the accessory tray of the cart and measure the mass of the cart plus bar. Record the mass in the Lab Report.

2.
Repeat the data recording process as in Part III.

Ending the Activity (See the section after Questions)

Analyzing the Data
1.
Use DataStudio or ScienceWorkshop to calculate and display the kinetic energy of the cart.

In DataStudio, do the following:

•
Open the ‘Calculator’ window. The window already has a calculation of kinetic energy based on a ‘Cart Mass’ of 0.4904 kg.

•
Enter the value of the mass of your cart under ‘Cart Mass’ in the ‘Calculator’ window. Click ‘Accept’ to record the change you made.

•
In the Graph of Kinetic Energy, use the built-in analysis tools to find the maximum KE.

[image: image25..pict]
(Hint: Use the ‘Smart Tool’ to find the maximum KE.)

In ScienceWorkshop, do the following:

[image: image26..pict]•
Open the ‘Experiment Calculator’ window.

•
In the formula area, type 0.5 and then click the ‘multiplication’ button ([image: image8.png]


). 

•
Type the value for the mass of your cart (0.5009 in the example), and click the ‘multiplication’ button again.
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Click the ‘INPUT Menu’ button ([image: image9.png]INFUT




). Select ‘Digital 1, Velocity (v).

•
Type ^2, which means to square the speed, after @1.v (the symbol for Digital 1, Velocity (v)).

•
Type ‘Kinetic Energy’ in the Calculation Name area. Type ‘KE’ in the Short Name area. Type ‘J’ in the Units area.

•
Click the equals button (=), or press <enter> or <return> on the keyboard. 

•
Click the Graph display to make it active. 
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Click the ‘Add Plot’ menu button ([image: image10.png]


) at the bottom of the Graph and select ‘Calculations, Kinetic Energy’. The Graph will show Velocity and Kinetic Energy for the data from Run #1.

•
Use the built-in analysis tools to find the maximum kinetic energy.

(Hint: Click the ‘Statistics Menu’ button in the Statistics area of the plot of Kinetic Energy. Select ‘All Of The Above’ from the Statistics Menu.) 

2.
Record the values of the maximum kinetic energy in the Lab Report.

3.
Calculate the elastic potential energy based on k and x. Record the value in the Lab Report.

Record your results in the Lab Report section.

Lab Report - Activity GS21: Conservation of Energy – PE to KE

Data Table

Item
Value

Mass (cart)
kg

Spring constant “k”
N/m

Plunger length “x”
m

Run #
1
2
3
Average

KE (J)



J

Elastic Potential Energy = 

= _______ J
Questions

1.
What is the difference between your value for the average kinetic energy and the elastic potential energy? 

2.
Which energy was larger in each case, the elastic potential energy or the kinetic energy of the cart? 

3.
What are possible reasons for the differences, if any?

Ending the Activity

Equipment Clean Up

•
Check with your instructor about putting away the equipment for this activity. 

Computer Shutdown

When you have finished, you have several options. 

1.
You can select Quit from the File menu to end the activity. 

2.
You can select Save or Save As… from the File menu to save your data for this activity and the changes you’ve made to the document. 

•
The original document is “locked”, so you should give your document a new filename.
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